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Preface

INTRODUCTION

This chapter contains general information that will be useful to know before using the 
MIC23356 Evaluation Board. Items discussed in this chapter include:

• Document Layout

• Conventions Used in this Guide

• Recommended Reading

• The Microchip Website

• Customer Support

• Document Revision History

DOCUMENT LAYOUT

This document describes how to use the MIC23356 Evaluation Board as a 
development tool. The manual layout is as follows:

• Chapter 1. “Product Overview” – Important information about the MIC23356. 

• Chapter 2. “Installation and Operation” – Includes instructions on how to get 
started with the MIC23356 Evaluation Board and a description of each function.

• Chapter 3. “GUI Installation and Operation” – Includes instructions on how to 
install the Graphical User Interface.

• Chapter 4. “GUI Description” – Describes the items in the Graphical User 
Interface

• Appendix A. “Schematic and Layouts” – Shows the schematic and layout 
diagrams for the MIC23356.

• Appendix B. “Bill of Materials (BOM)” – Lists the parts used to build the 
MIC23356 Evaluation Board.

• Appendix C. “MIC23356 Internal Registers” – Describes the internal registers.

NOTICE TO CUSTOMERS

All documentation becomes dated, and this manual is no exception. Microchip tools and 
documentation are constantly evolving to meet customer needs, so some actual dialogs 
and/or tool descriptions may differ from those in this document. Please refer to our website 
(www.microchip.com) to obtain the latest documentation available.

Documents are identified with a “DS” number. This number is located on the bottom of each 
page, in front of the page number. The numbering convention for the DS number is 
“DSXXXXXA”, where “XXXXX” is the document number and “A” is the revision level of the 
document.

For the most up-to-date information on development tools, see the MPLAB® IDE online help. 
Select the Help menu, and then Topics to open a list of available on-line help files.
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CONVENTIONS USED IN THIS GUIDE

This manual uses the following documentation conventions:

DOCUMENTATION CONVENTIONS

Description Represents Examples

Arial font:

Italic characters Referenced books MPLAB® IDE User’s Guide

Emphasized text ...is the only compiler...

Initial caps A window the Output window

A dialog the Settings dialog

A menu selection select Enable Programmer

Quotes A field name in a window or 
dialog

“Save project before build”

Underlined, italic text with 
right angle bracket

A menu path File>Save

Bold characters A dialog button Click OK

A tab Click the Power tab

N‘Rnnnn A number in verilog format, 
where N is the total number of 
digits, R is the radix and n is a 
digit.

4‘b0010, 2‘hF1

Text in angle brackets < > A key on the keyboard Press <Enter>, <F1>

Courier New font:

Plain Courier New Sample source code #define START

Filenames autoexec.bat

File paths c:\mcc18\h

Keywords _asm, _endasm, static

Command-line options -Opa+, -Opa-

Bit values 0, 1

Constants 0xFF, ‘A’

Italic Courier New A variable argument file.o, where file can be 
any valid filename

Square brackets [ ] Optional arguments mcc18 [options] file 
[options]

Curly brackets and pipe 
character: { | }

Choice of mutually exclusive 
arguments; an OR selection

errorlevel {0|1}

Ellipses... Replaces repeated text var_name [, 
var_name...]

Represents code supplied by 
user

void main (void)
{ ...
}
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RECOMMENDED READING

This user’s guide describes how to use the MIC23356 Evaluation Board. Another 
useful document is listed below. The following Microchip document is available and 
recommended as a supplemental reference resource:

• MIC23356 Data Sheet - “3A, Step-Down Converter with HyperLight Load™ 
and I2C Interface” (DS20006130)

THE MICROCHIP WEBSITE

Microchip provides online support via our website at www.microchip.com. This website 
is used as a means to make files and information easily available to customers. Acces-
sible by using your favorite Internet browser, the website contains the following infor-
mation:

• Product Support – Data sheets and errata, application notes and sample 
programs, design resources, user’s guides and hardware support documents, 
latest software releases and archived software

• General Technical Support – Frequently Asked Questions (FAQs), technical 
support requests, online discussion groups, Microchip consultant program 
member listing

• Business of Microchip – Product selector and ordering guides, latest Microchip 
press releases, listing of seminars and events, listings of Microchip sales offices, 
distributors and factory representatives

CUSTOMER SUPPORT

Users of Microchip products can receive assistance through several channels:

• Distributor or Representative

• Local Sales Office

• Field Application Engineer (FAE)

• Technical Support

Customers should contact their distributor, representative or field application engineer 
(FAE) for support. Local sales offices are also available to help customers. A listing of 
sales offices and locations is included in the back of this document.

Technical support is available through the website at: 
http://www.microchip.com/support.

DOCUMENT REVISION HISTORY

Revision A (December 2018)

• Initial release of this document


http://www.microchip.com/support

http://www.microchip.com/support
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Chapter 1.  Product Overview

1.1 INTRODUCTION

This chapter provides an overview of the MIC23356 Evaluation Board and covers the 
following topics:

• MIC23356 Short Overview

• What is the MIC23356 Evaluation Board?

• Contents of the MIC23356 Evaluation Board Kit

1.2 MIC23356 SHORT OVERVIEW

The MIC23356 device is a compact I2C programmable, high-efficiency, 3A continuous
current, synchronous step-down regulator. The Constant-ON-Time (COT) control
architecture with HyperLight Load™ (HLL) provides very high efficiency at light loads,
while still having ultra-fast transient response. The user can program, via the I2C
interface, various parameters, such as: output voltage, ON-time, soft start slope,
high-side current limit, HLL or Forced PWM mode of operation. The 2.4V to 5.5V input
voltage range, low shutdown and quiescent currents make the MIC23356 ideal for
single-cell, Li-Ion, battery-powered applications. 

An open-drain Power Good (PG) output is provided to indicate when the output voltage
is within 9% of regulation and facilitates output voltage monitoring and sequencing.
When set in Shutdown mode (EN = GND), the current consumption of MIC23356 is
reduced to 1.5 µA (typical).

The MIC23356 is available in a thermally-efficient, 16-Lead 2.5 x 2.5 x 0.55 mm thin 
MLF package, with an operating junction temperature range from -40°C to +125°C. 
More detailed information regarding the capabilities of the MIC23356 are available in 
the data sheet.

FIGURE 1-1: Typical MIC23356 Step-Down Application.
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1.3 WHAT IS THE MIC23356 EVALUATION BOARD?

The MIC23356 Evaluation Board is used to evaluate and demonstrate Microchip 
Technology’s MIC23356 product. This board demonstrates the MIC23356 in a buck 
converter application supplied from an external voltage source (2.4V-5.5V), with I2C 
programmed regulated output. The I2C Monitor GUI allows comprehensive control and 
status reporting with the MIC23356 device.

1.4 CONTENTS OF THE MIC23356 EVALUATION BOARD KIT

The MIC23356 Evaluation Board kit includes:

• MIC23356 Evaluation Board (ADM00881)

• Important Information Sheet.
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Chapter 2.  Installation and Operation

2.1 INTRODUCTION 

The MIC23356 Evaluation Board has been developed to test the MIC23356 device’s 
capabilities, including loading up to 3A and controlling and monitoring through the USB 
interface (via I2C Monitor GUI). Pin headers are also fitted for Bode Analysis and 
external I2C communication.

FIGURE 2-1: MIC23356 Step-Down Regulator with MCP2221 I2C Bridge.
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2.2 FEATURES

The MIC23356 Evaluation Board has the following features:

• Input Voltage Range 2.4V to 5.5V 

• 3A Continuous Output Current

• Multiple Faults Indication through I2C

• I2C Programmable:

- Output voltage: 0.6V-1.28V, 5 mV resolution

- Slew rate: 0.2 ms/V-3.2 ms/V

- Switching ON time (frequency)

- High-Side current limit: 3.5A - 5A

- Enable delay: 0.25 ms-3 ms

- Output discharge when disabled

• High Efficiency (up to 95%)

• ±1.5% Output Voltage Accuracy Overline/Load/Temperature Range

• Safe Start-Up with Pre-Biased Output

• Typical 1.5 µA Shutdown Supply Current

• Low Dropout (100% Duty Cycle) Operation

• Ultra-Fast Transient Response

• I2C Control up to 3.4 MHz

• Latch-Off Thermal Shutdown Protection

• Latch-Off Current Limit Protection

• Power Good Open-Drain Output

2.3 GETTING STARTED

The MIC23356 Evaluation Board is fully assembled and tested to evaluate and 
demonstrate the MIC23356 product. This board requires the use of external lab 
supplies and a PC. The MIC23356 is offered in four different product options, depend-
ing on the default settings at power-up, prior to any I2C write operation. The differences 
among the various product options are described in the MIC23356 data sheet. The 
Evaluation Board carries the -YFT option, whose default output voltage is 0.6V. All the 
device options may be fitted on the board, as is.

2.3.1 Power Input and Output Connection

2.3.1.1 POWERING THE MIC23356 EVALUATION BOARD

When the board is ready for evaluation, apply positive input voltage to the VIN terminal 
and the corresponding return to the GND-IN terminal. The maximum input voltage 
should not exceed 5.5V. An electronic load or resistive load can be used for evaluation. 
Some electronic loads can sink the programmed current starting from very low output 
voltage levels during start-up. For a more realistic start-up behavior evaluation, a 
resistive load or constant resistance is recommended. Connect the positive voltage 
terminal of the load to the VOUT terminal on the evaluation board and connect the 
negative or return side of the load to the GND-OUT terminal. If changing the regulator 
parameters is required or simply to monitor the part, make sure to connect the 
Micro-USB cable between the Evaluation Board and the PC. Then, install the GUI 
according to Chapter 3. “GUI Installation and Operation” and follow the indications 
in Chapter 2. “Installation and Operation” for more extensive evaluation.
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2.3.1.2  BOARD POWER-UP PROCEDURE

For the power-up procedure, follow the steps below:

1. Connect the PC, input supply, voltmeter, ammeter and load as shown in 
Figure 2-2. Set the ammeter on a 10A range.

2. Fit a jumper on the EN position across the J6 header, as marked on the silk-
screen.

3. Once the input voltage is greater than 2.35V at the board input (VIN), the device 
begins to switch.

4. The Voltmeter should now indicate an output voltage according to the preset 
register values. Adjusting the input voltage and load should not cause the output 
to vary more than a few mV over the operating range of the converter.

5. Set the input voltage and the load to the desired values, with a maximum of 5.5V 
on the input voltage and a maximum load of 3A.

6. Adjust the regulator output and monitor the STATUS registers, as described in 
Chapter 4. “GUI Description”.

7. Optionally, for more advanced readings, place Oscilloscope probe 1 in “SW” test 
point to monitor the switching waveforms and probe 2 on the output header 
(close to the output capacitors) to measure the AC ripple of the output voltage.

FIGURE 2-2: MIC23356 Evaluation Board Test Setup.

Note: The inductance associated with long wires on the board input may cause 
voltage spikes at load stepping or start-up into heavy load. If the spikes 
exceed the 5.5V maximum input voltage rating, the MIC23356 may fail. 
This can be prevented by populating a 470 µF Electrolytic Capacitor on C8 
footprint.
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2.3.1.3 PERFORMANCE EVALUATION

The Oscilloscope screen capture in Figure 2-3 displays the MIC23356 switching 
waveforms during normal operation, when supplied from 5V input at full load (3A).

FIGURE 2-3: Normal Operation at 0.6V Output, 3A Load.

FIGURE 2-4: Efficiency vs. IOUT at 1V.
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FIGURE 2-5: Efficiency vs. IOUT at 0.6V.

2.3.1.4 LOOP GAIN MEASUREMENT

The MIC23356 Evaluation Board provides injection points and a termination resistor 
(R12) for AC loop gain measurements. If needed, the value of R12 can be changed to 
optimize the injection signal level. Inject the oscillator at J9 through the insulation trans-
former (i.e., across resistor R12).

2.3.1.5 I2C PULL-UP VOLTAGE SELECTION

The MIC23356 Evaluation Board is equipped with a jumper for selecting the I2C pull-up 
supply voltage. The J8 header can be used to select the I2C pull-up voltage to either 
VUSB or VIN. If a different pull-up voltage is desired, it can be injected into the PWR pin 
of J2. In this case, make sure that no jumper is installed on header J8, to prevent short-
ing of the externally injected pull-up voltage to either VUSB or VIN.

2.3.1.6 USING THE MIC23356 EVALUATION BOARD WITH THE EXTERNAL I2C 
MASTER

In order to use the MIC23356 with an external I2C master (like a microcontroller, 
microprocessor or another I2C master), the on-board MCP2221 must be disabled. To 
accomplish this, the pull-down resistor R10 must be populated to avoid any interfer-
ence between the MCP2221 and the external I2C master. Then, the desired I2C master 
can be connected to J2. If the external I2C master already provides pull-up resistors for 
the SDA and SCL lines, then the I2C pull-up resistors R6 and R9, present on the 
MIC23356 Evaluation Board, are not needed and must be removed to prevent pull-up 
voltage conflicts.
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2.3.1.7 STARTING THE MIC23356 WITH A CUSTOM OUTPUT VOLTAGE

To power-up the MIC23356 with a custom output voltage, the MIC23356 Evaluation 
Board must be first powered-up with the MIC23356 disabled (either by placing the EN 
jumper on the J6 header, SDN position, or applying a Logic ‘0’ voltage on the EN test 
point). Program it via I2C interface to the desired output voltage and then start it by plac-
ing the EN jumper on J6, EN position (or by applying a Logic ‘1’ voltage on the EN test 
point). The MIC23356 does not retain the set voltage and returns to the default config-
uration after a power cycle.

2.3.1.8 MIC23356 EVALUATION BOARD ENABLE OPTIONS

In order to enable the MIC23356 on the Evaluation Board, three options are provided:

1. The EN jumper placed on the J6 header – by placing a jumper on the EN position 
as described by the silkscreen and by having EN_INT of register CTRL1 
(address 0x00) set to ‘1’, the MIC23356 is enabled. By placing a jumper on the 
SDN position, the MIC23356 is disabled. The MIC23356 Evaluation Board fea-
tures a pull-down resistor R3 connected to the EN pin, so, by default, without any 
jumper connected, the regulator will be disabled.

2. Software controlled – by clearing EN_INT (bit 1) of register CTRL1 (address 
0x00), the MIC23356 status is controlled by EN_CON (bit 0) of the CTRL1 reg-
ister and the EN pin status is ignored. By setting the EN_CON bit, the MIC23356 
is enabled and by clearing the EN_CON bit, the MIC23356 is disabled. 

3. MCP2221 GPIO control – by checking “Enable GP0 Control” in the I2CMonitor 
GUI, the EN pin is controlled by the GP0 output of the MCP2221 and by using 
the “GP0 active” button, the MIC23356 is enabled or disabled. 

2.3.1.9 PCB LAYOUT CONSIDERATIONS

For the best performance with the minimum occupied board space, some proper layout 
techniques should be applied. First, the input and output capacitors should be placed 
as close to the MIC23356 as possible and on the same layer as the IC. This will ensure 
low ripple and lower switching noise. Then, vias must be used under the MIC23356, 
from its exposed pad to the GND plane, in order to improve heat dissipation. Lastly, the 
switching node (from the SW pin of the MIC23356 to the inductor) should be as small 
as possible to decrease EMI emission.

2.3.1.10 BENCH TESTING AT HIGH CURRENTS

When testing the MIC23356 device at high-load currents or when checking the over-
current protection behavior, it may be necessary to remove the series ammeter shown 
in Figure 2-2 or to replace it with a very low-value shunt resistor. This is because the 
internal resistance of many Digital Multimeters (DMMs) used for current measurements 
is generally too high.

2.3.1.11 THERMAL CONSIDERATIONS

The MIC23356 Junction-to-Ambient Thermal Resistance JA, as measured on the 
Evaluation Board, is approximately +45°C/W. Depending on the loading conditions, 
ambient temperature, and device settings, the junction temperature might exceed the 
rated operating limit of +125°C due to internal power dissipation. Continuous operation 
above the maximum operating limits stated in the data sheet should be avoided.

Note: When using MCP2221 GPIO control, remove any low-impedance connec-
tion between the EN pin and VIN or GND (e.g., a jumper on the J6 header), 
as this may cause undefined behavior.
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Chapter 3.  GUI Installation and Operation

3.1 GETTING STARTED

In order to install, use and evaluate the product, several software and hardware tools 
are required.

3.1.1 Required Software

• I2C Monitor Graphical User Interface (minimum v.3.1.2)

• Microsoft®.NET Framework 4.5 or higher

• Adobe Acrobat Reader

3.1.2 Required Hardware

• MIC23356 Evaluation Board

• USB-to-micro-USB Cable

3.2 GRAPHICAL USER INTERFACE INSTALLATION

The following steps describe how to install the I2C Monitor Graphical User Interface:

1. If Microsoft®.NET Framework is already installed, go to Step 3. If not, download 
Microsoft®.NET Framework from www.microsoft.com and follow the installation 
instructions.

2. If Adobe Acrobat Reader is already installed, go to Step 3. If not, download 
Adobe Acrobat Reader from http://get.adobe.com/reader/ and follow the 
installation instructions.

3. Download the I2C Monitor Graphical User Interface (minimum v.3.1.2) archive 
from www.microchip.com/MIC23356, under “Documentation&Software”.

4. Unzip the I2C Monitor Graphical User Interface archive, which contains the 
setup.exe file.

5. Double click the setup.exe file to open the InstallShield Wizard window and 
wait for the extraction to complete. If required, the installation can be stopped by 
pressing the Cancel button.

Note: If an older version or a corrupted version of the current I2C Monitor 
Graphical User Interface is already installed on the computer, see 
Section 3.3 “I2C Monitor Graphical User Interface Uninstall” before 
proceeding with the installation.

https://get.adobe.com/ro/reader/
https://www.microsoft.com/ro-ro
https://www.microsoft.com/ro-ro
https://get.adobe.com/ro/reader/
https://get.adobe.com/ro/reader/
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6. In the Welcome to the InstallShield Wizard for I2CMonitor window, click the Next 
button to start the installation.

FIGURE 3-1: Starting the I2C Monitor Graphical User Interface Installation.

7. The installation path can be changed, although it is recommended to keep the 
default path. Click Next to continue.

FIGURE 3-2: Selecting the Destination Folder.
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8. In the Ready to Install the Program window, click the Install button and wait for 
the application to proceed with the installation. The progress can be observed in 
the “Status” bar.

.

FIGURE 3-3: Installing the I2C Monitor Graphical User Interface.
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9. Once the installation is complete, leave the “Launch the program” box checked 
to automatically start the I2C Monitor GUI, or deselect this check box to start the 
GUI at a later stage. Click Finish to end the installation. 

To start the GUI at a later stage, either click the desktop icon or browse to 
Windows Start>All Programs>Microchip>I2C Monitor.

FIGURE 3-4: The Installation Complete Window.

3.3 I2C MONITOR GRAPHICAL USER INTERFACE UNINSTALL

In order to install a new version of the I2C Monitor Graphical User Interface, any 
previous version or corrupted version should be removed from the computer.

To uninstall, go to Windows Start>Control Panel>Uninstall a program>I2CMonitor. The 
I2C Monitor GUI will automatically close once the uninstallation process is complete. 

FIGURE 3-5: Uninstalling the I2C Monitor Graphical User Interface.
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Chapter 4.  GUI Description

4.1 INTRODUCTION

This chapter describes how to use the I2C Monitor Graphical User Interface, using the 
MIC23356 Evaluation Board included in the kit.

FIGURE 4-1: I2C Monitor Graphical User Interface Main Window - MIC23356 View.

NOTICE

This chapter provides information regarding the use of the GUI only in the case of the 

MIC23356 device. For other devices using the I2C Monitor Graphical User Interface, see 
their specific Data Sheets and User’s Guides.

Status Bar
Progress Bar

MIC23356

Control by MCP2221 GP0 output

I2C Monitor Status
and 

Control Bar

I2C Generic 
Register View

MIC23356 I2C 
Programmable 

Features

MIC23356 I2C 
Diagnostic

Device Menu
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4.2 THE GRAPHICAL USER INTERFACE

The following sections describe the items in the Graphical User Interface.

4.2.1 Device Menu

The Device drop-down menu allows the user to select the device to be evaluated. If an 
evaluation (or added custom) board is used, the profile will automatically change to the 
preselected profile.

4.2.2 File Menu

The File menu allows the user to save (Save registers to file) the registers of the 
currently selected device to a file that can then be loaded into the GUI by using the 
Load registers from file button. The saved file can also be edited (open it with a text 
editor).

FIGURE 4-2: File Menu.

4.2.3 Settings Menu

From the Settings menu, add a new custom board to be automatically detected and 
switch to its profile. To do this, go to Settings>Device descriptors and in the Descriptors 
window, add the desired “Board” descriptor and select the desired “Device” profile.

FIGURE 4-3: Custom Board Menu.

4.2.4 I2C Monitor Status and Control Bar

The “Status and Control” bar contains the items in Table 4-1.

FIGURE 4-4: I2C Monitor Status and Control Bar.
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In the “Status and Control” bar the user can choose the hardware tool for the 
communication with the device and the settings it should allow.

In order to connect to a device, the user must follow the steps described in 
Section 2.3 “Getting Started”. After connecting the Micro-USB cable, the user must 
scan for a valid address. Once a valid address is detected, clicking the Connect button 
will initialize the connection with the device and the registers will be available for read 
and write operations.

4.2.5 I2C Generic Register View

The I2C Generic Register View area contains the items in Table 4-2. This section of the 
I2C Monitor GUI is common for any device evaluated.

FIGURE 4-5: Generic Register View Area.

The specific registers for MIC23356 are described in Appendix C. “MIC23356 
Internal Registers”.

TABLE 4-1: MONITOR STATUS AND CONTROL BAR

Item Description

Addr This drop-down menu shows the address of the available devices.

Connector This drop-down menu shows the type of connector used to connect the board.

ScanAddr This button is used to scan for a valid address.

Connect/Disconnect These buttons are used to connect/disconnect the current selected device.

Voltage This drop-down menu is used to select the voltage level of the communication when 
using PICkit™ Serial Analyzer.

Rate This drop-down menu is used to select the corresponding communication rate for the 
device.

Pull Ups This drop-down menu is used to activate the internal pull-ups from the PICkit Serial 
Analyzer.

Note 1: Optional. PICkit Serial Analyzer should first be connected on the I2C pin header, on the MIC23356 Evalu-
ation Board.

TABLE 4-2: I2C GENERIC REGISTER VIEW ITEMS

Panel Item Description

Operation Register This section shows the registers available for read/write operations.

Read/Write These buttons are used for single register read/write operations.

ReadAll/WriteAll These buttons are used for reading/writing all the available registers.

Number of Registers In this section, the user can set the number of available registers for 
read/write operations.

Update This button sets the number of available registers for read/write 
operations in the register area.

Register area This section shows the current status of the registers address and 
their content.
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4.2.6 MIC23356 I2C Programmable Features

The MIC23356 I2C “Programmable Features” area contains the items in Table 4-3.

FIGURE 4-6: MIC23356 I2C Programmable Features Area – Low Range.

FIGURE 4-7: MIC23356 I2C Programmable Features Area – High Range.
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This area of the GUI allows the user to modify the device features. For additional 
information on the part, refer to the data sheet.

TABLE 4-3: MIC23356 I2C Programmable Features
Panel/Button Items Description

Parameters EN Pin/Bit Enable 
Control

This check box allows switching between the I2C controlled device 
enable (checked) and pin controlled enable (unchecked). Leave this box 
unchecked to enable by jumper or MCP2221 GP0.

Enable Bit This check box sets the MIC23356 enable bit register. Check the box for 
regulator enabling, uncheck for disabling. This bit value is considered 
only if EN Pin/Bit Enable Control is checked.

Enable Delay This spin box allows setting the available start time delays.

Current Limit This spin box allows setting the available high-side current limits in order 
to obtain the nominal load currents.

ON Time This spin box allows setting the available ON-time values, that determine 
slower (high TON) or faster (lower TON) switching frequencies.

Slew Rate This spin box allows setting the available output slew rates.

Activate output 
pull-down when 
disabled

This check box activates automatic output pull-down resistor when the 
MIC23356 is disabled.

Latch off after 4 
OverTemp Cycles

This check box sets the latch off after four overtemperature (thermal 
shutdown) cycles.

Force PWM This check box sets forced PWM mode, regardless of output loading.

Disable 100% Duty 
Cycle

This check box disables 100% duty cycle operation on high side when 
VIN is close to VOUT. This feature is available only in High Range mode 
(option MIC23356-SAYFT).

Read/Write These buttons are used to read/write the registers that contain the 
information described above.

Output Voltage Voltage This spin box allows setting the available output voltages. If the evalu-
ated chip option is MIC23356-YFT, MIC23356-HAYFT or 
MIC23356-FAYFT, the Low Range option must be selected. If the evalu-
ated chip is MIC23356-SAYFT, High Range must be selected.

Read/Write These buttons are used to read/write the registers that contain the infor-
mation described above.

GP0 control Enable GP0 Control This check box allows enable control from the MCP2221 GP0 pin. If 
unchecked, pin GP0 is Tri-State.
To enable access to this feature and allow pin enable control, uncheck 
EN Pin/Bit Enable Control. 
The enable jumper must first be removed, to prevent short-circuiting GP0 
with the jumper. 

GP0 active This check box sets the state of the MCP2221 GP0 pin. Leave 
unchecked to disable the MIC23356 through Enable pin, or check the 
box to enable the MIC23356 regulator. 
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4.2.7 MIC23356 I2C Diagnostic

The MIC23356 Diagnostic area contains the items in Table 4-4.

FIGURE 4-8: MIC23356 I2C Diagnostic Area.

TABLE 4-4: MIC23356 I2C DIAGNOSTIC AREA ITEMS

Panel Items Description

Status Power Good This box is checked if the output voltage reaches 91% of its set 
value. 

Latched Off This box is checked if the regulator output is latched off, due to 
four consecutive hiccup events or thermal shutdown.

OverTemp 
Shutdown

This box is checked if the MIC23356 enters Thermal Shutdown 
(Typ. TJ = +165°C)

Current Limit This box is checked if the high-side sensed current reaches the 
value set in the “Current Limit” spin box. 

Soft Start Done This box is checked after successful regulator soft start ramp. 

Boot Up Error This box is checked if an error occurs while loading the trim and 
configuration data into the digital core. At successful start-up, this 
box remains unchecked (clear).

Buck Enabled This box indicates the internal state of the regulator, determined 
by enable commands (via EN pin or I2C)

OverTemp 
Warning

This box is checked if the MIC23356 junction temperature 
exceeds +118°C. This does not affect the normal operation of the 
device.
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The MIC23356 I2C Diagnostic area resumes the information contained in the STATUS 
register. The STATUS register contains latched (Flag) or non-latched (Status) bits. Flag 
bits are set when the corresponding Fault condition occurs and do not return to zero 
once the Fault condition ceases. If such a fault occurs, the user can clear the faults by 
toggling the enable function or power cycling the device. Status bits are set when the 
corresponding Fault condition has occurred, and return to zero automatically once the 
Fault condition has ceased. This information is refreshed once every two seconds. 

Because of this refresh traffic, when using a logic analyzer it is more difficult to 
synchronize the exact moment of a certain command. In order to simplify this, an 
auxiliary trigger signal is provided on pin GP2 of the MCP2221. This signal is triggered 
for each user Read/Write command.

TABLE 4-5: STATUS BAR ITEMS

Item Description

Status Label The status label shows if there is any device connected to the board. Refer to 
Table 4-6 for a list of possible labels.

Progress Bar This bar shows the level of completion for a given command.

TABLE 4-6: STATUS LABELS

Status Label Description

STATUS: Connected! This message is shown when the GUI connects to a device.

STATUS: Disconnected! This message is shown when the GUI does not detect a connected 
device.
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Appendix A. Schematic and Layouts

A.1 INTRODUCTION

This appendix contains the following schematic and layouts for the MIC23356 
Evaluation Board:

• Board – Schematic

• Board – Top Silk

• Board – Top Copper and Silk

• Board – Top Copper

• Board – Middle Layer 1

• Board – Middle layer 2

• Board – Bottom Copper

• Board – Bottom Copper and Silk

• Board – Bottom Silk
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A.2 BOARD – SCHEMATIC
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A.3 BOARD – TOP SILK

A.4 BOARD – TOP COPPER AND SILK
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A.5 BOARD – TOP COPPER

A.6 BOARD – MIDDLE LAYER 1
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A.7 BOARD – MIDDLE LAYER 2

A.8 BOARD – BOTTOM COPPER
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A.9 BOARD – BOTTOM COPPER AND SILK

A.10 BOARD – BOTTOM SILK



MIC23356
 EVALUATION BOARD

 USER’S GUIDE

 2018 Microchip Technology Inc. DS50002834A-page 33

Appendix B. Bill of Materials (BOM)

TABLE B-1: MIC23356 EVALUATION BOARD – BILL OF MATERIALS (BOM)

Qty. Reference Description Manufacturer Part Number

1 C1 Ceramic capacitor, 1 F, 16V, 10%, 
X7R, SMD, 0603

Yageo Corporation CC0603KRX7R7BB105

2 C2, C11 Ceramic capacitor, 4.7 F, 10V, 10%, 
X7R, SMD, 0805

TDK Corporation C2012X7R1A475K125AC

1 C3 Ceramic capacitor, 0.1 F, 16V, 10%, 
X7R, SMD, 0402

Murata Electronics 
North America, Inc.

GRM155R71C104KA88D

1 C5 Ceramic capacitor, 47 F, 10V, 20%, 
X7R, SMD, 1210

Taiyo Yuden Co., Ltd. LMK325B7476MM-TR

1 C6 Ceramic capacitor, 0.1 F, 16V, 10%, 
X7R, SMD, 0603

AVX Corporation 0603YC104KAT2A

1 C8 Aluminum capacitor, 470 F, 16V, 
20%, RAD, P3.5D8H11.5

Nichicon Corporation UVZ1C471MPD

1 C9 Ceramic capacitor, 22 F, 10V, 20%, 
X7S, SMD, 0805

TDK Corporation C2012X7S1A226M125AC

4 J1, J3, J12, J13 Connector, HDR-2.54, Male, 1x2, 
Gold, 5.84MH, TH, Vertical

FCI 77311-118-02LF

2 J14, J21 Misc, Test Point, Multi Purpose, Mini, 
Red

Keystone 
Electronics Corp.

5000

3 J17, J18, J20 Misc, Test Point, Multi Purpose, Mini, 
Black

Keystone 
Electronics Corp.

5001

1 J2 Connector, HDR-2.54, Male, 1x4, Tin, 
5.84MH, TH, Vertical

FCI 68002-404HLF

4 J4, J5, J15, J19 Connector, TP, PIN, Tin, TH Harwin Plc. H2121-01

2 J6, J8 Connector, HDR-2.54 Male, 1x3, Tin, 
5.84MH, TH, Vertical

Samtec, Inc. TSW-103-07-T-S

1 J7 Connector, USB 2.0, Micro-B, Female 
SMD R/A

FCI 10118193-0001LF

0 J9 NOT POPULATED FCI 77311-118-02LF

1 L1 Inductor, 350 nH, 3.3A, 20%, SMD, 
L3.2W3.5H1.5

Coilcraft XEL3515-351

1 PCB1 MIC23356 Evaluation Board – Printed 
Circuit Board

Microchip 
Technology Inc.

04-10741-R1

1 R1 Resistor, TKF, 49.9R 1%, 1/10W, 
SMD, 0603

Panasonic® - ECG ERJ-3EKF49R9V

0 R10 NOT POPULATED Panasonic - ECG ERJ-3GSY0R00V

1 R12 Resistor, TKF, 10R 1%, 1/10W, SMD, 
0603

Panasonic - ECG ERJ-3EKF10R0V

1 R3 Resistor, TKF, 1M, 1%, 1/10W, SMD, 
0603

Panasonic - ECG ERJ-3EKF1004V

Note 1: The components listed in this Bill of Materials are representative of the PCB assembly. The released BOM 
used in manufacturing uses all RoHS-compliant components.
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4 R4, R5, R8, R11 Resistor, TKF, 0R 1/10W, SMD, 0603 Panasonic - ECG ERJ-3GSY0R00V

2 R6, R9 Resistor, TKF, 2 k 1%, 1/10W, SMD, 
0603

Panasonic - ECG ERJ-3EKF2001V

1 R7 Resistor, TKF 100 k 1% 1/10W SMD 
0603

Panasonic - ECG ERJ-3EKF1003V

1 U1 Microchip Analog Switcher Buck 2.4V 
to 5.5V MIC23356YFT FTQFN-16

Microchip 
Technology Inc.

MIC23356YFT

1 U2 Microchip Interface USB I2C UART 
MCP2221A-I/ST TSSOP-14

Microchip 
Technology Inc.

MCP2221A-I/ST

TABLE B-2: BILL OF MATERIALS – MECHANICAL PARTS

Qty. Reference Description Manufacturer Part Number

2 JP1, JP2 Mechanical HW Jumper, 2.54 mm, 1x2, 
Phosphor Bronze w/ Handle

Jameco Valuepro 2012JH-R

1 LABEL1 Label, Assembly w/Rev Level (Small 
Modules) Per MTS-0002

— —

4 PAD1, PAD2, 
PAD3, PAD4

Mechanical HW Rubber Pad, Cylindri-
cal, D7.9 H5.3, Black

3M SJ61A11

Note 1: The components listed in this Bill of Materials are representative of the PCB assembly. The released BOM 
used in manufacturing uses all RoHS-compliant components.

TABLE B-1: MIC23356 EVALUATION BOARD – BILL OF MATERIALS (BOM) (CONTINUED)

Qty. Reference Description Manufacturer Part Number

Note 1: The components listed in this Bill of Materials are representative of the PCB assembly. The released BOM 
used in manufacturing uses all RoHS-compliant components.
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Appendix C. MIC23356 Internal Registers

C.1 REGISTER MAP AND I2C PROGRAMMABILITY

The MIC23356 internal registers are summarized in Table C-1.

TABLE C-1: MIC23356 REGISTER MAP

Address Register Name

0x00 Control Register (CTRL1)

TON<1:0> Reserved ILIM EN_DELAY<1:0> EN_INT EN_CON

0x01 Output Control Register (CTRL2)

DIS_100PCT FPWM OT_LATCH PULL_DN SLEW_RATE<3:0>

0x02 Output Voltage Register (VOUT)

VO<7:0>

0x03 STATUS and FAULT Register (FAULT)

OT_WARN EN_STAT BOOT_ERR SSD HICCUP OT LATCH_OFF PG

REGISTER C-1: CTRL1 – CONTROL REGISTER (ADDRESS 0X00)

R/W-0 R/W-0 R-1 R/W-0 R/W-0 R/W-0 R/W-0 R/W-0

TON Reserved ILIM EN_DELAY EN_INT EN_CON

bit 7 bit 0

Legend:

R = Readable bit W = Writable bit U = Unimplemented bit, read as ‘0’

-n = Value at POR ‘1’ = Bit is set ‘0’ = Bit is cleared x = Bit is unknown

RC = Read-then-clear bit

bit 7-6 TON<7:6>: ON Time bits

00 = Low Frequency
01 = Medium Frequency
10 = High Frequency
11 = Very Fast Frequency

bit 5 Reserved bit

bit 4 ILIM: High-Side Peak Current Limit bit

0 = 3.5A
1 = 5A

bit 3-2 EN_DELAY<3:2>: Enable Delay bits

00 = 250 µs
01 = 1 ms
10 = 2 ms
11 = 3 ms

bit 1 EN_INT: Enable Bit Register Control bit

0 = Register Controlled
1 = Enable Controlled
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bit 0 EN_CON: Enable Control bit

0 = Off
1 = On

REGISTER C-1: CTRL1 – CONTROL REGISTER (ADDRESS 0X00) (CONTINUED)

REGISTER C-2: CTRL2 – OUTPUT CONTROL REGISTER (ADDRESS 0X01)

R/W-0 R/W-0 R/W-0 R/W-0 R/W-0 R/W-0 R/W-0 R/W-0

DIS_100PCT FPWM OT_LATCH PULLDN SLEW_RATE

bit 7 bit 0

Legend:

R = Readable bit W = Writable bit U = Unimplemented bit, read as ‘0’

-n = Value at POR ‘1’ = Bit is set ‘0’ = Bit is cleared x = Bit is unknown

RC = Read-then-clear bit

bit 7 DIS_100PCT: Disable 100% Duty Cycle bit

0 = 100% DC
1 = Disable 100% DC

bit 6 FPWM: Force PWM bit

0 = HLL
1 = FPWM

bit 5 OT_LATCH: Overtemperature Latch bit

0 = Latch Off Immediately
1 = Latch Off after 4 OT Cycles

bit 4 PULLDN: Enable/Disable Regulator Pull-Down When Power Down bit

0 = No Pull Down
1 = Pull Down

bit 3-0 SLEW_RATE<3:0>: Step Slew-Rate Time in µs/V bits

0000 = 200
0001 = 400
0010 = 600
0011 = 800
0100 = 1000
0101 = 1200
0110 = 1400
0111 = 1600
1000 = 1800
1001 = 2000
1010 = 2200
1011 = 2400
1100 = 2600
1101 = 2800
1110 = 3000
1111 = 3200
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REGISTER C-3: OUTPUT VOLTAGE CONTROL REGISTER (ADDRESS 0X02)

R/W-0 R/W-0 R/W-0 R/W-0 R/W-0 R/W-0 R/W-0 R/W-0

VO

bit 7 bit 0

Legend:

R = Readable bit W = Writable bit U = Unimplemented bit, read as ‘0’

-n = Value at POR ‘1’ = Bit is set ‘0’ = Bit is cleared x = Bit is unknown

RC = Read-then-clear bit

bit 7-0 VO<7:0>: Output Voltage Control, options YFT, --HAYFT, -FAYFT bits

0x00-0x76 = 0.6V 0x80 = 0.645 0xA0 = 0.805V 0xC0 = 0.965 0xE0 = 1.125V

0x81 = 0.65V 0xA1 = 0.81V 0xC1 = 0.97V 0xE1 = 1.13V

0x82 = 0.655V 0xA2 = 0.815V 0xC2 = 0.975V 0xE2 = 1.135V

0x83 = 0.66V 0xA3 = 0.82V 0xC3 = 0.98V 0xE3 = 1.14V

0x84 = 0.665V 0xA4 = 0.825V 0xC4 = 0.985V 0xE4 = 1.145V

0x85 = 0.67V 0xA5 = 0.83V 0xC5 = 0.99V 0xE5 = 1.15V

0x86 = 0.675V 0xA6 = 0.835V 0xC6 = 0.995V 0xE6 = 1.155V

0x87 = 0.68V 0xA7 = 0.84V 0xC7 = 1V 0xE7 = 1.16V

0x88 = 0.685V 0xA8 = 0.845V 0xC8 = 1.005V 0xE8 = 1.165V

0x89 = 0.69V 0xA9 = 0.85V 0xC9 = 1.01V 0xE9 = 1.17V

0x8A = 0.695V 0xAA = 0.855V 0xCA = 1.015V 0xEA = 1.175V

0x8B = 0.7V 0xAB = 0.86V 0xCB = 1.02V 0xEB = 1.18V

0x8C = 0.705V 0xAC = 0.865V 0xCC = 1.025V 0xEC = 1.185V

0x8D = 0.71V 0xAD = 0.87V 0xCD = 1.03V 0xED = 1.19V

0x8E = 0.715V 0xAE = 0.875V 0xCE = 1.035V 0xEE = 1.195V

0x8F = 0.72V 0xAF = 0.88V 0xCF = 1.04V 0xEF = 1.2V

0x90 = 0.725V 0xB0 = 0.885V 0xD0 = 1.045V 0xF0 = 1.205V

0x91 = 0.73V 0xB1 = 0.89V 0xD1 = 1.05V 0xF1 = 1.21V

0x92 = 0.735V 0xB2 = 0.895V 0xD2 = 1.055V 0xF2 = 1.215V

0x93 = 0.74V 0xB3 = 0.9V 0xD3 = 1.06V 0xF3 = 1.22V

0x94 = 0.745V 0xB4 = 0.905V 0xD4 = 1.065V 0xF4 = 1.225V

0x95 = 0.75V 0xB5 = 0.91V 0xD5 = 1.07V 0xF5 = 1.23V

0x96 = 0.755V 0xB6 = 0.915V 0xD6 = 1.075V 0xF6 = 1.235V

0x77 = 0.6V 0x97 = 0.76V 0xB7 = 0.92V 0xD7 = 1.08V 0xF7 = 1.24V

0x78 = 0.605V 0x98 = 0.765V 0xB8 = 0.925V 0xD8 = 1.085V 0xF8 = 1.245V

0x79 = 0.61V 0x99 = 0.77V 0xB9 = 0.93V 0xD9 = 1.09V 0xF9 = 1.25V

0x7A = 0.615V 0x9A = 0.775V 0xBA = 0.935V 0xDA = 1.095V 0xFA = 1.255V

0x7B = 0.62V 0x9B = 0.78V 0xBB = 0.94V 0xDB = 1.1V 0xFB = 1.26V

0x7C = 0.625V 0x9C = 0.785V 0xBC = 0.945V 0xDC = 1.105V 0xFC = 1.265V

0x7D = 0.63V 0x9D = 0.79V 0xBD = 0.95V 0xDD = 1.11V 0xFD = 1.27V

0x7E = 0.635V 0x9E = 0.795V 0xBE = 0.955V 0xDE = 1.115V 0xFE = 1.275V

0x7F = 0.64V 0x9F = 0.8V 0xBF = 0.96V 0xDF = 1.12V 0xFF = 1.28V
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bit 7-0 VO<7:0>: Output Voltage Control, option -SAYFT bits

REGISTER C-3: OUTPUT VOLTAGE CONTROL REGISTER (ADDRESS 0X02) (CONTINUED)

0x00-0x3A = 
0.6V

0x40 = 0.65V 0x60 = 0.97V 0x80 = 1.3V 0xA0 = 1.94V 0xC0 = 2.58V 0xE0 = 3.22V

0x41 = 0.66V 0x61 = 0.98V 0x81=1.32V 0xA1 = 1.96V 0xC1 = 2.6V 0xE1 = 3.24V

0x42 = 0.67V 0x62 = 0.99V 0x82 = 1.34V 0xA2 = 1.98V 0xC2 = 2.62V 0xE2 = 3.26V

0x43 = 0.68V 0x63 = 1V 0x83 = 1.36V 0xA3 = 2V 0xC3 = 2.64V 0xE3 = 3.28V

0x44 = 0.69V 0x64 = 1.01V 0x84 = 1.38V 0xA4 = 2.02V 0xC4 = 2.66V 0xE4 = 3.3V

0x45 = 0.7V 0x65 = 1.02V 0x85 = 1.4V 0xA5 = 2.04V 0xC5 = 2.68V 0xE5 = 3.32V

0x46 = 0.71V 0x66 = 1.03V 0x86 = 1.42V 0xA6 = 2.06V 0xC6 = 2.7V 0xE6 = 3.34V

0x47 = 0.72V 0x67 = 1.04V 0x87 = 1.44V 0xA7 = 2.08V 0xC7 = 2.72V 0xE7 = 3.36V

0x48 = 0.73V 0x68 = 1.05V 0x88 = 1.46V 0xA8 = 2.1V 0xC8 = 2.74V 0xE8 = 3.38V

0x49 = 0.74V 0x69 = 1.06V 0x89 = 1.48V 0xA9 = 2.12V 0xC9 = 2.76V 0xE9 = 3.4V

0x4A = 0.75V 0x6A = 1.07V 0x8A = 1.5V 0xAA = 2.14V 0xCA = 2.78V 0xEA = 3.42V

0x4B = 0.76V 0x6B = 1.08V 0x8B = 1.52V 0xAB = 2.16V 0xCB = 2.8V 0xEB = 3.44V

0x4C = 0.77V 0x6C = 1.09V 0x8C = 1.54V 0xAC = 2.18V 0xCC = 2.82V 0xEC = 3.46V

0x4D = 0.78V 0x6D = 1.1V 0x8D = 1.56V 0xAD = 2.2V 0xCD = 2.84V 0xED = 3.48V

0x4E = 0.79V 0x6E = 1.11V 0x8E = 1.58V 0xAE = 2.22V 0xCE = 2.86V 0xEE = 3.5V

0x4F = 0.8V 0x6F=1.12V 0x8F = 1.6V 0xAF = 2.24V 0xCF = 2.88V 0xEF = 3.52V

0x50 = 0.81V 0x70 = 1.13V 0x90 = 1.62V 0xB0 = 2.26V 0xD0 = 2.9V 0xF0 = 3.54V

0x51 = 0.82V 0x71 = 1.14V 0x91 = 1.64V 0xB1 = 2.28V 0xD1 = 2.92V 0xF1 = 3.56V

0x52 = 0.83V 0x72 = 1.15V 0x92 = 1.66V 0xB2 = 2.3V 0xD2 = 2.94V 0xF2 = 3.58V

0x53 = 0.84V 0x73 = 1.16V 0x93 = 1.68V 0xB3 = 2.32V 0xD3 = 2.96V 0xF3 = 3.6V

0x54 = 0.85V 0x74 = 1.17V 0x94 = 1.7V 0xB4 = 2.34V 0xD4 = 2.98V 0xF4 = 3.62V

0x55 = 0.86V 0x75 = 1.18V 0x95 = 1.72V 0xB5 = 2.36V 0xD5 = 3V 0xF5 = 3.64V

0x56 = 0.87V 0x76=1.19V 0x96 = 1.74V 0xB6 = 2.38V 0xD6 = 3.02V 0xF6 = 3.66V

0x57 = 0.88V 0x77 = 1.2V 0x97 = 1.76V 0xB7 = 2.4V 0xD7 = 3.04V 0xF7 = 3.68V

0x58 = 0.89V 0x78 = 1.21V 0x98 = 1.78V 0xB8 = 2.42V 0xD8 = 3.06V 0xF8 = 3.7V

0x59 = 0.9V 0x79 = 1.22V 0x99 = 1.8V 0xB9 = 2.44V 0xD9 = 3.08V 0xF9 = 3.72V

0x5A = 0.91V 0x7A = 1.23V 0x9A = 1.82V 0xBA = 2.46V 0xDA = 3.1V 0xFA = 3.74V

0x3B = 0.6V 0x5B = 0.92V 0x7B = 1.24V 0x98 = 1.84V 0xBB = 2.48V 0xDB = 3.12V 0xFB = 3.76V

0x3C = 0.61V 0x5C = 0.93V 0x7C = 1.25V 0x9C = 1.86V 0xBC = 2.5V 0xDC = 3.14V 0xFC = 3.78V

0x3D = 0.62V 0x5D = 0.94V 0x7D = 1.26V 0x9D = 1.88V 0xBD = 2.52V 0xDD = 3.16V 0xFD = 3.8V

0x3E = 0.63V 0x5E = 0.95V 0x7E = 1.27V 0x9E = 1.9V 0xBE = 2.54V 0xDE = 3.18V 0xFE = 3.82V

0x3F = 0.64V 0x5F = 0.96V 0x7F = 1.28V 0x9F = 1.92V 0xBF = 2.56V 0xDF = 3.2V 0xFF = 3.84V
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REGISTER C-4: STATUS AND FAULT REGISTER (ADDRESS 0X03)

R-0 R-0 R-0 R-0 R-0 R-0 R-0 R-0

OT_WARN EN_STAT BOOT_ERR SSD HICCUP OT LATCH_OFF PG

bit 7 bit 0

Legend:

R = Readable bit W = Writable bit U = Unimplemented bit, read as ‘0’

-n = Value at POR ‘1’ = Bit is set ‘0’ = Bit is cleared x = Bit is unknown

RC = Read-then-clear bit

bit 7 OT_WARN: Overtemperature Warning bit

0 = No Fault
1 = Fault

bit 6 EN_STAT: Buck ON/OFF Control bit

0 = OFF
1 = ON

bit 5 BOOT_ERR: Boot-Up Error bit

0 = No Fault
1 = Fault

bit 4 SSD: Soft Start Done bit

0 = Ramp not Done
1 = Ramp Done

bit 3 HICCUP: Current Limit Hiccup bit

0 = Not in Hiccup
1 = In Hiccup

bit 2 OT: Overtemperature bit

0 = No Fault
1 = Fault

bit 1 LATCH_OFF: Overcurrent or Overtemperature Output Latch Off bit

0 = No Fault
1 = Fault

bit 0 PG: Power Good bit

0 = Power Not Good
1 = Power Good
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